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Introduction This application note describes how to test DDR or DDR2 SDRAM

interfaces on Altera® development boards using the Altera DDR or DDR2
SDRAM Controller MegaCore® function-generated example driver. The
example driver—a stand-alone synthesizable circuit—demonstrates the
DDR or DDR2 SDRAM interface. You can use these instructions to
quickly build a DDR or DDR2 SDRAM interface on one of the Altera
boards and see it working; or use the same principles to establish whether
the DDR or DDR2 SDRAM interface on your board is working as
expected, independently of any other circuit.

[l=~  This application note describes a DDR2 SDRAM Controller
example driver, but is applicable to the Altera DDR SDRAM
Controller.

Figure 1 shows the example system block diagram.

Figure 1. Example System Block Diagram
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Test DDR or DDR2 SDRAM Interfaces on Hardware

Overview

This application note details the following topics that help you build a
stand-alone synthesizable circuit that demonstrates the DDR2 SDRAM
interface:

“Overview” on page 2

“Set Up the Quartus II Project” on page 3

“Generate a DDR2 SDRAM Controller MegaCore Function” on
page 5

“Edit the PLL” on page 14

“Compile the Design” on page 17

“Select the Board Pin Outs” on page 16

“Set Up the SignalTap II Logic Analyzer” on page 18

“Program the Device” on page 23

A PC running the Quartus® II software downloads the device
programming file and monitors the activity on the DDR2 SDRAM
Controller local interface. The Quartus II SignalTap® I utility captures the
activity on the DDR2 SDRAM Controller local interface via the JTAG
connector.

The driver is a self-checking test generator for the DDR2 SDRAM
controller. The driver uses a state machine to write data patterns to a
range of column addresses, within a range of row addresses in all
memory banks. The driver then reads back the data from the same
locations, and checks that the data matches. The pnT (pass not fail) output
transitions low if any read data fails the comparison. There is also a
pnf_per_byte output, which shows the comparison on a per byte basis.
The test_complete output transitions high for a clock cycle at the end
of the write then read sequence. After this transition the test restarts from
the beginning and repeats indefinitely.

For more information on pnf_per_byte, refer to “Appendix A:
Interpret the pnf_per_byte Output” on page 24.

The data patterns are generated with an 8-bit linear feedback shift register
(LFSR) per byte—each LFSR has a different initialization seed.

The application note requires the following hardware and software:
B Cyclone™ II PCI Development Board, available in the PCI High-
Speed Development Kit, Cyclone II Edition

B DDR2 SDRAM Controller MegaCore function
B Quartus II software

= The principles in this application note are the same for any
Altera development board.
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Set Up the Quartus Il Project

Set U p the To set up the Quartus II project, follow these steps:
Quartus II 1. Follow the instructions in the PCI High-Speed Development Kit,
Prﬂject Cyclone II Edition, Getting Started User Guide to correctly install your

Cyclone II PCI Development Board.

2. Start the Quartus II software and create a new project by choosing
New Project Wizard (File menu).

3.  On page 3 of 5 of the New Project Wizard in the Family drop-down
box choose Cyclone II. In the Available Devices list choose
EP2C35F672C6.

4. Click Finish.

«®  For more information, see the DDR & DDR2 SDRAM Controller Compiler
User Guide.
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Test DDR or DDR2 SDRAM Interfaces on Hardware

Fitter Effort

You must ensure the Quartus II Fitter Effort is set to standard, for the best
timing placements—timing placements are essential for a DDR2 SDRAM
interface.

v/ To set the fitter effort, choose Settings > Fitter Settings > Fitter
effort = Standard Fit (highest effort) (Assignments menu), see
Figure 2.

Figure 2. Fitter Settings

"

Settings - example_ver_proj

Category:
General Fitter Settings
Files
User Libraries [Current Project] Specify options for fitting.
Device

¥

Timing Analyziz Settings

—- EDA Tool Settings
Dresign Entry/Synthesis [v Optimize hold timing: |I.-"D Fathz and Minimum TPD Paths j
Simulation
Timing Analysiz
Formal Verification
Physical Spnthesis PowerFlay power optimization: |N0rmal compilation j
Board-Lewvel

Compilation Process Settings

Timing-driven compilation

[~ Optimize fast-cormer timing

Fitter effart

- . i it [hi
Early Timing E stimate + Standard Fit [highest effort]
Incremental Compilatian " Fast Fit [up ta 50% faster compilation # may reduce fmax)
Timing Analysiz Processing ™ Auto Fit [reduce Fitter effort after meeting timing requirements]

Analyzis & Synthesiz Settings ’—_|
WHOL Input
Werilog HOL Input
Default Parameters [~ Limit to ore fitting attempt

Synthesiz Metlist Optimizations T
Fitter Settings Seed:
Physical Synthesiz Optimizations
Aszembler More Settings...

Dresign Assistant
SignalT ap Il Logic Analyzer

Logic Analyzer Interface Description:
SignalProbe Settings Controls the fitter's trade-off between performance and compilation speed. Auto Fit adjusts the
=I- Simulator Settings fitter optimization effort to minimize compilation time, while still achieving the design timing E
Simulation Power requirements. The FITTER_AUTO_EFFORT_DESIRED_SLACK_MARGIMN option can be used

to request that Auto Fit apply sufficient optimization effort to achieve additional timing margirn. v

(] 8 | Cancel

¥

PowerFlay Power Analyzer Settings

Unused Pins

You must ensure other unused pins on the device are tri-stated inputs
(because the unused pins still attach to various devices on the
development board), by following these steps:
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Generate a DDR2 SDRAM Controller MegaCore Function

Generate a
DDR2 SDRAM
Controller
MegaCore
Function

Altera Corporation

1. Choose Assignments > Settings > Device > Device & Pin Options
> Unused Pins, and for Reserve all unused pins select As inputs,
tri-stated (see Figure 3). Click OK, and click OK.

Figure 3. Device & Pin Options

a

Device & Pin Options g|

WVoltage ] Fin Placement ] Error Detection CRC ] Capacitive Loading ]
General ] Configuration ] Programming Files Unused Ping l Dwal-Purpoze Ping ]

Specify device-wide options for reserving all unuzed pinz on the device. To reserve
individual dual-purpose configuration pins, go to the Dual-Purpose Pins tab. To
reserve other ping individually, use the Assignment Editor,

Feserve all unused pins:

Drescription:

Feserves all unused ping on the target device in one of 5 states: az inputs that are
tri-stated, as outputs that drive ground, as outputs that drive an unspecified signal.
ag input tri-stated with bus-hold, or as input tri-stated with weak pull-up.

(] 8 | Cancel |

To generate a DDR2 SDRAM Controller MegaCore Function, follow these
steps:

1. Choose MegaWizard Plug-in Manager (Tools menu), select Create
a new custom megafunction variation and click Next.

2. In the Device drop-down box choose Cyclone II. For the output file
type select VHDL or Verilog HDL, and enter a name, for example,
test.

= The <variation name> must be a different name from the project
name and the top-level design entity name.

3. Choose DDR2 SDRAM Controller <version> in the Interfaces >
Memory Controllers directory.



Test DDR or DDR2 SDRAM Interfaces on Hardware

4. Click Next (see Figure 4).

Figure 4. Select the Megafunction

MegaWizard Plug-In Manager [page 2a] PZ|
Wwhich megafunction would you like to customize™? W_hicr; device family will you be Cyclone |1 -
Select a megafunction from the list below I

=[] Inztalled Plug-lns ~ Wwhich type of output file do you want to create?
Altera SOPC Builder «
+- il AnthmetlF: . ¢ wHDL
+ @8 Commurications .
&3 DSP + Verilog HDL
: g ﬁ;tes what name do you want for the output file? Browse...
- Interfaces C:halterahproject'ddi_itest
+ & AS

+- @8 HyperTransport

-8 Memory Controllers

;] DDR SDRAM Controller «
| DOF SDRAM Controllsr «
DDR2 SDRAM Controller Mate: To compile a project successfully in the Quartus || software,
your design files must be in the project directory, in the global user
libraries specified in the Dptions dialog box [Tools menu), or a uzer

library specified in the User Libraries page of the Settings dialog
bow [Assignments menu).

™ Retumn to this page for anather create operation

“Y'our current user library directories are:

| Project User Libraries:
LA Asourcehdema’

LI Express L hasourcebte_iph

L hasourcebrtp tsh

Cancel | < Back | Mest » | |

Parameterize the DDR2 SDRAM Controller
To parameterize the DDR2 SDRAM Controller, follow these steps:

1. Click Step 1: Parameterize.
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Generate a DDR2 SDRAM Controller MegaCore Function

2. In the Presets list, choose Micron MT47H16M16BG-5E (see
Figure 5), which selects the correct settings on each tab for this
device.

Figure 5. Choose Memory Device

& Parameterize - DDRZ SDRAM Controller

Presets; w | Clock Speed: MHz {6000 ps)

Micron 256Mbit x16 DDR2-400 chip Device: EP2C35 Fe7z Co

Memary | Contraller | Contraller Timings | Memory Timings | Board Timings | Project Settings | Manual Timings

Memory Interface

Data bus width: 16 | Local width = 32
Mumber of chip selects: 1 w
Mumber of chip selects per DIMM: 1 w
Mumber of clock pairs from FPGEA to memary: |1 w

Memary Properties

Memory size: 32 ME
Row address bits: 13 v
Column address bits: 2 v

Bank address bits: z v
Precharge address bit: | 10 w

D bits per DQS pin:

3. Click the Controller Settings tab.

4. Turn on Insert extra pipeline registers on address and command
outputs (see Figure 6), which inserts an extra pipeline stage between
the DDR2 SDRAM Controller and the input-output element (IOE)
register to improve fyax. Do not change any other settings.
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Test DDR or DDR2 SDRAM Interfaces on Hardware

Figure 6. Controller Settings

& Parameterize - DDRZ SDRAM Controller

Presets; w | Clock Speed: MHz {6000 ps)

Micron 256Mbit x16 DDR2-400 chip Device: EP2C35 F&72 C6
Memary | Controller | Controller Timings | Memaory Timings | Board Timings | Project Settings | Manual Timings

Local Interface Clocking Options

(&) Native () Awalon

Memory Initialization Options

QDT Setting: Disabled % | Ohi
etting isable n Memary Controller Options

CAS latency: 3.0 w

Insert pipeline registers on address and command outputs
Burst length: 4 w
B i @ sequentisl O Interlesved Insert extra pipeline registers in the datapath
Drive strength:  (3) Normal O Reduced Clock addressfcommand output registers on the negative edge
Memaory device DLL enable [[J User contralled refresh

DLL Reference Clock Options

5. Click the Board Timings tab.

6. For the FPGA Clock output to memory chip clock input, nominal
delay, enter 700ps; for the Memory DQ/DQS outputs to FPGA
inputs, nominal delay, enter 700ps (see Figure 7 on page 9).

Il="  These settings are for the Cyclone Il PCI Development Board.

For other Altera board settings, see “Appendix B. Useful
Development Board Information” on page 26.
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Generate a DDR2 SDRAM Controller MegaCore Function

Figure 7. Board Timings

& Parameterize - DDRZ SDRAM Controller

Presets; w | Clock Speed: MHz {6000 ps)

Micron 256Mbit x16 DDR2-400 chip Device: EP2C35 F&72 C6
Memary | Controller | Controller Timings | Memaory Timings | Board Timings | project Settings | Manual Timings
Fin Loading

[] Manual pin laad control

Fin loading on FRGA DQYDQS pins: pF
Fin loading on FPGA address/command pins: pF
Fin loading on FPGA clock pins: pF

Board Trace Delays

FPGA clock output to memory chip clock input, nominal delay: 700 ps
Memory DOYDOS outputs bo FPGA inputs, nominal delay: 700 ps
Fed-back clock trace, nominal delay: ps
Tolerance of nominal board delays +/- 5 o
‘Worst trace skew between DQYDOQS/DM in any one data group: | 20 ps

7. Click Finish on the Parameterize - DDR SDRAM Controller
window.

Choose DQS Group Placement for the DDR2 SDRAM Controller

To choose DQS group placement for the DDR2 SDRAM Controller, follow
these steps:

1. Click Step 2: Constraints.

2. Set2T =0and 4T =1 (settings for the Cyclone II PCI Development
board). See Figure 8.

Altera Corporation 9



Test DDR or DDR2 SDRAM Interfaces on Hardware

10

Figure 8. Constraints

€ Constraints - DDR2 SDRAM Controller

Selected Device

Famihr Cyclone |l
Device: EP2C3S
Package: FE72
Speed Grade: CG

1T =v 3T (- % | ST |- | 4T (1 »| 2T |0 »| OT |- v

2L |- v Top R |- v
0L |- OR |- v
1L ¥ 1R R
S g Bottom E g

1B |- w| 3B |- | 5B |- %| 4B|-—|¥| 2B|—|v| OB|-|w

I'="  Assignments made here must match your board layout—which
is design dependant. The IP Toolbench-generated constraints set
up the pin assignments, LogicLock™ regions, IO standards, and
other constraints. Therefore, these groupings must match the
pin out on the board.

I For the settings for other Altera boards, run the appropriate
reference board’s constraints Tcl file, which is in the \1ib
directory of the MegaCore function. See “Select the Board Pin
Outs” on page 16.

3. Click OK on the Constraints - DDR2 SDRAM Controller window.

Set Up Simulation

To set up simulation, follow these steps:

L=~  This application note explains the steps to simulate a Verilog
HDL design. Follow the same steps to simulate a VHDL design.

To generate an IP functional simulation model for your MegaCore
function, follow these steps:

1. Click Step 3: Set Up Simulation in IP Toolbench (see Figure 9).
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Generate a DDR2 SDRAM Controller MegaCore Function

Figure 9. IP Toolbench—Set Up Simulation

© DDRZ SDRAM .. [2 )]0 )X

i

MegaCore®

—

|| bout this Core

E Step 1:
Farameterize

DDRZ2 SDRAM Controller v3.4.0

Step 4:
7 Generate

2. Turn on Generate Simulation Model (see Figure 10).

Figure 10. Generate Simulation Model

© Set Up Simulation - DDR2 SDRAM Controller =3
IP Functional Simulation Model

Language Yerilog HOL M

An [P Functional Simulation Model is a cycle-accurate WHDL or Verilog
HOL madel produced by the Quartus® Il software. These models
allow fast functional simulations of IP using industry-standard YHDL
and Yerilog HOL simulators.

You may anly use these simulation madel output files for simulation
purposes and expressly not for synthesis or any other purposes.
Using these madels for synthesis will create a non-functional design.

Cancel ] ’ Ok
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Test DDR or DDR2 SDRAM Interfaces on Hardware

3. Choose the language in the Language list.

5

To use the IP Toolbench-generated testbench, choose the

same language that you chose for your variation.

4. Click OK.

Generate the DDR2 SDRAM Controller

«o  Forinstructions and tips on functional simulation, see “Appendix C.
Perform Functional Simulation” on page 27.

To generate the DDR2 SDRAM Controller, follow these steps:

1. Click Step 4: Generate on the DDR2 SDRAM Controller window.

2. When the MegaCore Function Generation Successful message
appears, click Exit on the Generation - DDR2 SDRAM Controller
window.

Increase the Example Driver Address Range

Figure 11 shows a system-level diagram including the example instance
that the DDR2 SDRAM Controller MegaCore function creates for you.

Figure 11. DDR SDRAM Controller System-Level Diagram
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Generate a DDR2 SDRAM Controller MegaCore Function

Altera Corporation

To test more of the memory, you can increase the example driver address
range, if not go to “Edit the PLL” on page 14. To increase the address
range of the example driver, follow these steps:

1.

In the Quartus II software, choose Open (File menu) and choose
<wvariation name>_driver.vhd or .v, in this example choose
test_example_driver.vhd or .v.

Search for the following line in VHDL:

MAX_ROW <= std_logic_vector" (**0000000000011");
For Verilog HDL, search for the following line:

Assign MAX_ROW = 3;

Change the line to the following VHDL code:

MAX_ROW <= to_stdlogicvector(**0000000000001*" sll1
(memory row bits -1));

For Verilog HDL, change the line to the following code:
Assign MAX_ROW = 1<<(memory row bits - 1);

[l Replace memory row bits with your value for the memory
row bits on the Memory Settings tab.

Search for the following line in VHDL:

MAX_COL <= std_logic_vector" (**0000010000');
For Verilog HDL, search for the following line:

Assign MAX_COL = 16;

Change the line to the following VHDL code:

MAX_COL <= to_stdlogicvector(**'0000000001" sll
(memory column bits -1));

For Verilog HDL, change the line to the following code:
Assign MAX_COL = 1<<(memory column bits - 1);

L= Replace memory column bits with your value for the memory
column bits on the Memory Settings tab.

13



Test DDR or DDR2 SDRAM Interfaces on Hardware

Edit the PLL The IP Toolbench-generated PLL has an input to output clock ratio of 1:1
and a clock frequency that you entered in IP Toolbench. However, the
Cyclone II PCI Development Board uses a 100-MHz input clock. To

update the PLL for the design, follow these steps:

1. Choose MegaWizard Plug-in Manager (Tools menu), select Edit an
existing custom megafunction variation and click Next.

2. Choose ddr_pll_cycloneii.vhd and click Next (see Figure 12).

14

Figure 12. Choose ddr_pll_cycloneii

MegaWizard Plug-In Manager [page 2b]

Wwhich custom megafunction variation file do you wish to edit?

Lok ir: |a DDF_Poard_test j

(ddb
ddrz_331v
&

(Ctesthench

File narme: |ddr_p||_c:yc:|0neii.v

Filez of type:

¥ Show only wizard-generated files

™ Return to this page for another edit operation

The current megafunction variation iz bazed on the megafunction shown below. [f
you want to uze a different megafunction az the basis for your changes to this
custom wariation, select a different megafunction name:

Megafunction name: ALTPLL

Cancel | < Back | Mest > |
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Edit the PLL

3. On ALTPLL [page 3 of 10], in What is the frequency of the inclock0
input? enter 100 MHz (see Figure 13). Click Next four times.

s This setting is design dependant, and may be different in your
design.

Figure 13. Set the PLL Frequency

MepaWizard Plug-In Manager [page 3 of 10]

i ALTPLL

Yersion 6.0

Able to implement the requested PLL
ddr_pll_cyclonsii

General
ncka o
WOE ok fraquency: 100,000 MHz Ai ‘which device family will you be using?
Operation bvde: Normal [N
2
Clkc Fatio [Fr g oc ¢3))
<a [15essernoooaon| a0 | soan Wihich device speed grade will you be using?
o1 | 1666667000000 -00.00 | 50.00
1 [1s0ese71000000| 38,00 | s0.00 Wihat is the frsquency of the inclock( input? 100,00
Tyclene Il ~
PLL type

“Which PLL type will you be using?

%) Selsct the PLL type automatically

Operation mads
How will the PLL outputs be generated?
& Use the feedback path inside the PLL
) In Normal Mode
£ In Source-Synchronous Compensation Mode
3 In Zero Delay Buffer Mode
22 with no compensation

wiihich output clock will be compensated for? el v

[ cancel || <gack |[ mext> || Ersh |
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Test DDR or DDR2 SDRAM Interfaces on Hardware

4. On ALTPLL [page 7 of 10], for CO select Enter output clock
Frequency and in Requested Settings enter 166.7MHz (see
Figure 14). This setting should match your memory clock speed.
Ignore the Cannot Implement the Requested PLL error message
and click Next.

Figure 14. Set Clock Speeds for Each PLL Output

2

MepaWizard Plug-In Manager [page 6 of 10]

ALTPLL

Yersion 6.0

o0 - CorefExternal Output Clack.

ddr_pll_cycloneii Able to implement the requested PLL

PRk { oot traquency: 100.000 Mz
Operation Made: Nomal

1 Lise this clock

HE

Clock Tap Settings
Requested settings Actual settings

ik

Rati Ph g OC (4]

16665671000000

o0 | 5000 % Enter output clock fraquency: 1666657000 | MHz |& 166,666667

166671000000

000 | 50,00

16665671000000

139.00] 5000 Enter output clock parametsrs:

Clock multiplication Factor 5

Tyelone 11

e ] S

e

Clock division Factor

Clock phass shift 0.00

KBl
.

&
<
o
g

Clock duty cycle (%) 50.00 50,00

More Details = >

Kl

Per Clock Feasibility Indicators
co oc1locz

Select the Board

Pin Quts

16

5. Repeat for C1, C2. For C1 clock, set the Clock phase shift to -90
degrees; for the C2 clock, —135 degrees.

6. Click Finish.
['="  InIP Toolbench, if you want to regenerate your design, turn off

Automatically generate the PLL, so IP Toolbench does not
overwrite the changes that you made to the PLL.

To select the appropriate pin out for the Cyclone II PCI Development
Board, follow these steps:

1. Choose Tcl Scripts (Tools menu).
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Compile the Design

2. Choose cycloneii_pci_rev_a_pins in the
c:/MegaCore/ddr_ddr2_sdram-<version>/lib/ directory and click
Run (see Figure 15).

Figure 15. Pin Out Tel Script

Tcl Scripts g|

Libraries:

EHEr modelsim

-~
LEN ddri2_331_ddr_sdram_vsim Open File

= @' C:/altera/megacore/ddr_ddr2_sdram-+3.3.1/lib/

; £d cycloneii_dsp_rev_a_pins Add to Tel Toolbar
+fd) cycloneii_nias_ping
Cancel

Fun

i ev_a_ping
>E:.1 cyclone_mem_board_pins
~Eal strativi_hzin_pinz
R
%]

shrativii_pci_rev_a_pins

stratixii_s2mb&_dimm_pins b
Preview:
# e
# Pin & Location Assigmnments for Cyclone II PCI Board
#
# NE The clock input is 100MHz!! Don't forget to chang
# the PLL.
#

# This board uses the following byte groups
# DOS0 = 2T, DQ31 = 4T, DQ3IZ = 3T, DQ33 = 5T,

< *

s There is one file for each supported Altera memory
development board. For your own board design, manually
create one of these files using on of the files as a guide or use the
Quartus II Assignment Editor to assign your pins.

When the script is complete, the following message displays:

Info: Successfully loaded and ran Tcl Script File
"'C:\MegaCore\ddr_ddr2_sdram-
<version>\1ib\cycloneii_pci_rev_a pins.tcl”

COmp| le the Before the Quartus II software compiles the design, it runs the IP
. Toolbench-generated Tcl constraints script, auto_add_constraints.tcl.
Design
v/ Choose Start Compilation (Processing menu), which runs the add

constraints scripts, compiles the design, and performs timing
analysis.

-« For more information on the constraints script and timing analysis, see
the DDR & DDR2 SDRAM Controller Compiler User Guide.
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Test DDR or DDR2 SDRAM Interfaces on Hardware

Set Up the
SignalTap I
Logic Analyzer

18

When the compilation is complete, the Quartus II processing messages
tab displays the post-compilation timing analysis results. The results are
also written to the <wvariation name>_post_summary.txt file in your project
directory.

The results show how much slack you have for each of the various timing
requirements—negative slack means that you are not meeting timing.

If the verify timing script reports that your design meets timing, you have

successfully generated and implemented your DDR SDRAM Controller.

& The verify timing script checks the round trip delay, but it does
not check that your FPGA can run at this frequency. You should
check the fyax of your system using the Quartus II timing
analysis to ensure that your internal logic runs at the desired
speed.

To set up your SignalTap II settings to observe your design working on
your board, follow these steps:

1. Choose SignalTap II Logic Analyzer (Tools menu).
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Set Up the SignalTap Il Logic Analyzer

2. In the Signal Configuration window;, click the ... button (see
Figure 16).

Figure 16. Signal Configuration Window

Signal Configuration: x

Clock: I

—Data:

Sample depth; [ Modes allocated —————————————
|128 'l ’76 Auto C Manual m
Fi&sh type:

r— Buffer acquisition mode:

& Circular: I?ﬁ Pre trigger position j
" Segmented: |128 1 bit zegments j
— Trigger:

I‘I 'l @ Auo O Manual ID _|::'

Trigger levels: "Nodes allocated:

1T Trigger in:
Source: I J
Pattern: I Don't Care j

1 Trigger out:

Target: I j J

Level: I Active High j

Latency delay: I
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Test DDR or DDR2 SDRAM Interfaces on Hardware

3. Inthe Named box enter *clk* and click List (see Figure 17).

Figure 17. Add Clock

H
Mamed: I"c:lk" j Filter: ISignaITap I: pre-spnthesis j Custarnize. .. | List | ()8 |
Loak in: jJ IV Include subentities Stop | Cancel |
Modes Found: Selected Modes:

Mame | Aszsighments I 'AI Mame | Aszsighments I T
£ clk_to_sdram_n[1] Unassigned [J

B shrativ_dos_ref_clk Unaszigned |

& test_auk_ddr_didilclk Unassigned

& altddio_out:dgs_ref

& testtest_ddr_sdramlclk
1]

& altddio_out:dgs_ref_clk_out_plack  Unassigned
& altddio_out:dgs_ref_clk_out_plaset Unassigned
5 altddio_out:dgs_ref_clk_out_pld... Unassigned
& altddio_out:dgs_ref_clk_out_pld... Unassigned
5 altddio_out:dgs_ref_clk_out_pld... Unassigned
& altddio_out:dgs_ref_clk_out_pld... Unassigned
5 altddio_out:dgs_ref_clk_out_pld... Unassigned
& altddio_out:dgs_ref_clk_out_pld... Unassigned
& altddio_out:dgs_ref_clk_out_plmux  Unassigned
& altddio_out:dgs_ref_clk_out_ploe  Unassigned
& altddio_out:dgs_ref_clk_out_plo..  Unassigned
& altddio_out:dgs_ref_clk_out_plo..  Unassigned

& ddr_pll_stratiz:g_stratizpl_ddr_pll... Unassigned

EX

ENESE B

<€

Unassigned

Unazzigned [*

2|

20

4. Choose test_example_driver:driver|clkin the Nodes
Found list and click > to add to the Selected Nodes list.

5. Click OK.

6. In the Signal Configuration window, choose the following settings:
e Inthe Sample depth box choose 512

In the RAM type box choose M-RAM

e In Buffer acquisition mode select Circular: Center trigger
position

7. Choose Add nodes (Edit menu).
s Do not add any DDR SDRAM interface signals (DQ or DQS),

because the additional logic, which the SignalTap II logic
analyzer adds, adversely affects your timings.
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Set Up the SignalTap Il Logic Analyzer

8. Inthe Named box enter *local* and click List (see Figure 18).

Figure 18. Add SignalTap Il Nodes

%]
Mamed: I"Iocal" j Filter: ISignaITap I: pre-spnthesis j Custarnize. .. | List | ’TI
|_PRO_DDR_Buid jJ V' Include subentities Stop |Start node search lncel |
Modes Found: Selected Modes:
Mame | Azsignments & Mame | Agsignments | T
&3 example_driver:diverlocal_bank_a.. Unassigned
“& example_driverdiverlocal_bank_a.. Unassigned
“& example_driverdiverlocal_bank_a.. Unassigned
5 example_driver:diverlocal_be Unassigned
& example_driver:driverllocal_be0] Unassigned
& example_driver:driverllocal_be[1] Unassigned
& example_driver: driverllocal_be[2] Unassigned _>I
& example_driver:driverlocal_be[3] Unassigned
& example_driver:driverllocal_be[4] Unassigned LI
& example_driver: driverllocal_be[5] Unassigned
& example_driver: driverllocal_be[5] Unassigned _<I
& example_driver: driverllocal_be[7] Unassigned iI
& example_driver: driverllocal_be[3] Unassigned
& example_driver:driverllocal_be[3] Unassigned
& example_driver: driverllocal_be[10] Unassigned
& example_driver: driverlocal_be[11] Unassigned
& example_driver: driverllocal_be[12] Unassigned
& example_driver: driverllocal_be13] Unassigned
& example_driver: driverllocal_be[14] Unazsigned ¥
< | _’l_I | | i

2|

9. Choose the following signals in the Nodes Found list and click > to
add to the Selected Nodes list:

example_driver:driver]local_rdata
example_driver:driver]local_rdata_valid
example_driver:driver]local_read_req
example_driver:driver]local_wdata
example_driver:driver]local_wdata_req
example_driver:driver]local_write_req

10. In the Named box enter *pnf* and click List.

11. Choose the following signals in the Nodes Found list and click > to
add to the Selected Nodes list:

e pnf
e pnf_per_byte

12. In the Named box enter *test_complete* and click List.
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13. Choose the test_complete signal in the Nodes Found list and
click > to add to the Selected Nodes list.

14. Click OK in the Node Finder window.

15. To reduce the SignalTap logic size, turn off Trigger Enable on the

following signals (see Figure 19):

e example_driver:driver|local_rdata

e example_driver:driver]local_wdata
e pnf_per_byte
Figure 19. Trigger Enable
auto_signaltap_0 Lock mode: Ié\A"DW all changes j
Hode Incr: tal |Debug Port Data Enable | Trigger Enable | Trigger Leuels_[‘

Type | Alias Hame Route 278iAuto 6/Auto 1 | Basic -
Fe) - ..iver:driver|local_rdata I I I
ey ...erdriverflocal_rdata_valid I I I 22
ey .. Iver:driverflocal_read_req I I I 22
Fe) F- ..erdriverlocal_wdata I I I
ey .. iver:driverflocal_write_req I I I 22
ey ...dr_sdram|local_write_req I I I 22
o pnif r 2 ¥ 2=
= - pnf_per_tyte r I r
o test_complete I I I 22
z Drata @ Setup |

22
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16. Right click on the test_complete Trigger Levels cell and set to
trigger on a Rising Edge (see Figure 20).

Figure 20. Rising Edge

Program the
Device

Altera Corporation

To program the device, follow these steps:

1.

auto_signattap_0 Lock made: Ié\Allow all changes j
Hode Incr: tal |Debug Port Data Enable | Trigger Enable | Trigger Levels
Type | Alias Hame Route Out 278iAuto 6/Auto 1V |Basic |
= - ..dverdriver|locsl_rdsta I I I
o ..erdriver|local_rdsta_valid I I~ I~ 22
o . iverdriver|local_read_req I I I 22
= - ..erdriverlocal_wdsta I I I
o . iverdriver(local_write_reg I I I 22
o ...dr_sdram|local_write_req I I I 22
o pnif r 2 ¥ 2=
o - pnf_per_byte r |4 r
s v v
ZE Don't Care
£ Lo
Y Faliing Edge
Wil ringedge |
T High
X Either Edge
z Data % Setup Insert Yalue, ., |

17. Choose Save (File menu), and choose Yes to the prompt Do you
want to enable SignalTap II File stp1.stp for the current project?

18. Re-compile the design to add the SignalTap II probes, by choosing
Start Compilation (Processing menu).

19. When compilation is complete, connect your download cable (for
example, ByteBlaster™ II download cable) to the JTAG port on the
development board.

20. In the SignalTap II logic analyzer in the JTAG Chain Configuration
window:

e In the Hardware list, choose ByteBlasterII [LPT1]
e In the Device list, choose EP2C35
e Inthe SOF Manager list, choose <project name>.sof

Click the Program Device icon that is next to SOF Manager (see

Figure 21).
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Figure 21. Program Device

JTAG Chain Configuration: |JTAG ready [z) X

Hardware: |ElyteElIasterMV [LFT1] ﬂ Setup...
Device: |@2: EF1 SZSI_HARDCOF’Y_FPGA_PROTOﬂ Zcan Chain

>> | SOF Manager: & 0 |test_p|atf0rm.sof l:l

Program Device Icon

2. Click Run Analysis to run once; click Autorun Analysis to run

continuously. See Figure 22.

Figure 22. Analysis

log: 2005/03/08 10:34:40 #0

click to insert time bar

Typefflias]  Name o o B B B BB B BB B
< sdram|local_read_req |

< riverlocal_rdata_valid

> sdramllocal_rdata LR im0 i 123085540

= dramilorsal_wdata 0 o o e oo i sz D i
< dram|local_write_req [

cd river|local_wdata_req f

o pnf

5 - pnf_per_byte : Fh

o test_complete N

< >
E Data | & Setup

Reads Writes

Appendix A:
Interpret the
pnf_per_hyte
Output

24

Figure 23 shows an example of how to interpret the pnf_per_byte
output. This example uses a 24-bit wide data bus—three DQS pins and six
pnf_per_byte signals. The numbers on the rising and falling edges of
the DQS signals represent the pnf_per_byte[5:0] bus. For example, if
pnf_per_byte[3] is zero and all other pnf_per_byte outputs are
high, there is an error on the data clocked by the DQS[0] falling edge.
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Figure 23. Interpret the pnf_per_byte Output

DQS[2]

DQS[1]

DQS[0]

e
G

Figure 24 shows example local_rdata, local_wdata, and
pnf_per_byte signals for this example.

s The pnf_per_byte output is three cycles after local_rdata.

Figure 24. Example Signals

local_rdata_valid [ \—/7
IocalfrdataﬁXBXCXDXEXFXGX H [ ]

local_wdata AXBXCXDXEXFXGXHX | XJ

pnf_per_byte _ 38 X 3F X aF XsF X 3F X aF X aF X 3F .

Table 1 shows generally how to interpret any errors on the
pnf_per_byte signal.

Table 1. Interpret pnf_per_byte Errors

Error in Position Interpretation

A If the postamble logic is too late, you can miss capturing
A, by not enabling on time.

H If the postamble logic is too early, you can miss capturing
F; by disabling too soon, you see E twice.
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Append ix B. Table 2 shows a summary of the board level design information for

Useful
Development
Board
Information

various Altera IP evaluation boards.

Table 2. Altera Evaluation Boards Note (1)

f FPGA-to-Memory | Memory-to-FPGA
Board SDRAM (I\;lef\l);) Delay (ps) ! Delzy (ps)
Stratix Memory Demonstration Board 1 DDR 200 1,400 1,400
Stratix PCI Development Board DDR 200 1,200 1,200
Stratix PCI High-Speed Development Board DDR 167 1,200 1,200
Stratix GX Video Development Board DDR - 1,000 1,000
Stratix || Memory Demonstration Board 1 DDR 200 1,400 1,400
Stratix || Memory Demonstration Board 2 DDR2 267 1,400 1,400
Nios Il Development Board, Cyclone Il Edition DDR 167 550 550
Cyclone™ DDR Memory Board DDR 133 500 500
Twister DDR-SDRAM Evaluation Kit DDR 133 500 500
Cyclone Il DSP Development Board DDR2 167 1,400 1,400
Cyclone Il PCI Development Board DDR2 167 700 700

Note to Table 2:

(1)  The figures are for operation at room temperature and have not been verified over the full process, voltage,

temperature (PVT) range.
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Appendix C.
Perform
Functional
Simulation

Altera Corporation

The DDR2 SDRAM Controller generates all the controller files with the
testbench. The testbench files are located in the <project name>\testbench
directory.

The Verilog HDL testbench (<variation name>_sim_tb.v) requires the

modifications to match to your particular memory model. To simulate the

design, follow these steps:

1. Download the simulation model of the memory type that you
selected in the DDR2 SDRAM Controller - Parametrize window

into the <project name>\testbench directory.

2. Copy any parameter file (if separate from the model) in to the
<project name>\testbench\modelsim directory.

3. Open <variation name>_sim_tb.v in a text editor.

4. Locate the line generic_ddr_sdram_rtl memory_ 0O_O.
5. Replace generic_ddr_sdram_rtl with the <modelname>.
6. Ensure all signal names match those used in your model.

7. Repeat for all memory instances in the testbench.

Il="  The automatic testbench generation assumes each memory
model is a x8 device—has one DQS per DQ group and each
chip is a single x8 device.

If you have a x16 device, follow these steps to ensure the testbench DQ,

DQS, and DM signals match the model, otherwise go to “Increase the

Example Driver Address Range” on page 12.

1. Check the if def statements within the parameters file and add
the appropriate define statements to the top of the memory model.

For example, for Micron models set the speed grade and number of

DQ to DQS pins.

2. Start the ModelSim simulator and change directory to the
\testbench\modelsim.

3. Type the following commands

set memory_model <model name>
source <wvariation_name>_ddr_sdram_vsim._tcl
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For example to use two Micron MT47H16M16BG -5E x16 DDR devices to
make a 32-bit DDR SDRAM interface, follow these steps:

1.

10.

11.

In the DDR SDRAM IP Toolbench, select Micron
MT47H16M16BG -5E in the Presets: list.

= If the memory model is not available, add the model to the
memory_types.dat file in the <DDR installation
directory>\ddr_ddr2_sdram-v#\constraints directory.
Click the Memory tab and select 32 for the Data bus width.
Click Finish.

In IP Toolbench, click Set Up Simulation and turn on generation for
a Verilog HDL simulation model.

Click Finish.

In IP Toolbench, click Generate to generate the custom MegaCore
variation.

Download the MT47H16M16BG -5E Verilog HDL model from the
Micron website.

Extract the ddr.v model to the <project name >\testbench directory.

Rename the ddr_parameters.vh file to ddr_parameters.v and move
it to the <project name>\testbench\modelsim directory.

Open <variation name>_sim_tb.v in a text editor.
The IP Toolbench-generated testbench creates 4 x 8 devices.

However, the DDR memory model is a x16, so you require a 2 x 16
memory model instantiation. Locate the following line:

generic_ddr_sdram_rtl memory_0 0 (

12.

Replace generic_ddr_sdram_rtl with the model name, for
example ddr eg.

ddr memory_0_0 (

13.

14.

Repeat for memory_0_2.

Delete the instance memory_0_1 and memory_0_3 as these are not
required.
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15. Change the width of DQ, DQS, and DM to correctly match the
model. For example change the following code:

//generic_ddr_sdram_rtl memory_0_0(

// -Dg (mem_dq[8* (0+1) - 1 - 8 * 0]),
// .Dgs (mem_dgs[0]),
// -Addr (a_delayed[11: 0]),
// -Ba (ba_delayed),
// .Clk (clk_to_ram),
// -.Clk_n (clk_to_ram_n),
// -Cke (cke_delayed[0]),
// .Cs_n (cs_n_delayed[0]),
// -Ras_n (ras_n_delayed),
// .Cas_n (cas_n_delayed),
// We_n (we_n_delayed),
// -Dm (dm_delayed[0])
17/ ):

To the following code:

ddr2 memory 0_0 (

-Dq (mem_dq[15:0]),//Updated

.Dgs  (mem_dqgs[1:0]), //Updated

-Addr (a_delayed[11: 0]),

-Ba (ba_delayed),

-Clk  (clk_to_ram),

-Clk_n (clk_to_ram_n),

-Cke (cke_delayed[0]),

.Cs_n (cs_n_delayed[0]),

-Ras_n (ras_n_delayed),

.Cas_n (cas_n_delayed),

We_n (we_n_delayed),

-Dm (dm_delayed[1:0]) //Updated
):

and:

ddr2 memory_0_2 (

.Dg (mem_dq[31:16]),//Updated
.Dgs  (mem_dgs[3:2]),//Updated
-Addr (a_delayed[11: 0]),

.Ba (ba_delayed),

-Clk  (clk_to_ram),

-Clk_n (clk_to_ram_n),

.Cke (cke_delayed[0]),

.Cs_n (cs_n_delayed[0]),

-Ras_n (ras_n_delayed),

.Cas_n (cas_n_delayed),

We_n (we_n_delayed),

-Dm (dm_delayed[3:2])//Updated
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16. Save the testbench.
17. Open the DDR model and set the following define statements:

“define sg5E
“define x16

These statements ensure the model is behaving as a x16 device with
the correct speed grade.

18. Start the ModelSim simulator and change directory to the
<project>\testbench\modelsim directory.

19. At the command prompt type the following command:

set memory_model ddr

20. On the Tools menu, click Execute Macro and select <variation
name>_ddr_sdram_vsim.tcl.
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